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Chapter 7: Horizontal and Vertical Design

Introduction

Since there are many different, and acceptable, methods of creating
horizontal and vertical geometry using GEOPAK, this chapter will not
dictate the exact methods to use. Instead we will describe the different
methods that can be used and provide a workflow for a macro that will
check the horizontal alignment design for kinks, once completed. This
chapter will be in two sections: Horizontal Design and Vertical Design.

Horizontal Design

There are four methods of setting a horizontal alignment: Coordinate
Geometry (COGO), Graphical COGO, Horizontal Alignment Generator,
and Store Graphics. Any of these methods are acceptable to CFLHD.
Each one of these methods has their advantages and disadvantages,
since graphical COGO and the horizontal alignment generator are
similar, we will address these tools together. This chapter will describe
each of the above listed methods and indicate their advantages and
disadvantages. Regardless of the method used, the final
alignment must be drawn into MicroStation using the GEOPAK
D&C Manager, with the CFLHD .ddb file. This will assure that the
elements are drawn with the correct symbology, matching the CFLHD
standards.

Coordinate Geometry

Coordinate Geometry can be accessed using Project Manager by
selecting the Coordinate Geometry button.

& Road Project: FHWA. prj
File Remember Opkions

Wweorking Directory:  o\vour_ProjectRoadwaphD ezign ke Jelic Job# 101 |

v “wWoarking Alignment [nfuence Funs

. ) . Define Part Wigwer
YWhorking Alignment  Untitled |
Ewigting
Ground Ewizgting Ground Ewizgting Ground | Wertical
Draw Pattern . - .
Crozs Sectionz Frofile | Alignment
Coordinate
Geannetry
Calculate Supereleyation

Fropogzed a0
Models

Shapes Cross Sections

Superelevation
Horizantal
Aligrment
Plar igw E arthwork Cross Section
Deszign Sheets
Plan View Tabular -
Quantities Summaries

Plan & Profile Limnitg of Reportz & =5
Sheets Construction Quantities

Figure 7-1. Accessing COGO through Project Manager
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You can also select the Coordinate Geometry button on the GEOPAK
main dialog box.

Figure 7-2: Accessing COGO through Road Tools Icon

If you are using Project Manager, Coordinate Geometry dialog box will
be invoked. Otherwise, the Job Number and Operator code will have
to be entered in the COGO Startup dialog box. Project Name and
Subject are optional fields. Press the OK button to bring up the
Coordinate Geometry window.

& Coordinate Geometry Job: 101 Operator: JD

File it Element View Tools User

A «| +].4

AMNa& A&l & 2l 2] o] ad s

*| grgg12 |« ¢

ﬁﬂ W Bedefine
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Figure 7-3: Coordinate Geometry

You can create the horizontal geometry by typing commands in at the
COGO command line, by creating an input file with a sequence of
COGO commands and loading it into COGO, or by using the dialog
box driven Store Curve from Tangents, Locate Traverse, etc., tools
that are accessed from the COGO pull down menus to generate the
commands. If you use the input file method, remember that the COGO
input file name can only be 8 characters long, must have the job
number as the last three digits in the name, and the extension has to
have an “i"+ the operator code. (i.e. XXXXX101.ijd), where the i
stands for input file.

Advantages.
e This method allows the user to have more precise control over
tangent bearings, control point coordinates, etc., than with

Store Graphics, if done properly.

e The user can set visualization on to view progress of design.

STANDARDS FOR USE WITH X30 CRITERIA
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Disadvantages.

¢ Commands for the command line and input file methods are
difficult to memorize.

e Small adjustments are hard to make.

e Process is time consuming.

e Reviewing both horizontal and vertical alignments.
e Creating output of alignments for printing.

o Tweaking alignments that were created using store graphics, or
any of the other methods.

e Storing as-built centerline chain and profiles, especially those
for which there are only hard copy paper plans.

Graphical COGO

Graphical COGO allow the user to create coordinate geometry
elements using COGO tools with graphic and a user-friendly process.
Graphical COGO can be accessed by selecting:

Applications>GEOPAK ROAD>Geometry>Graphical
Coordinate Geometry

Applications  Window  Help
GECPAE
GECPAK BRIDGE
GECPAK DRAINAGE
GECPAK LANDSCAPE
GECH A0
GECPAE SITE
GECPAE SURVEY
GEOPAK WATER SEWER.
SigniCAD

GEOPAK ROAD Tools

Project Manager

Site Modeling

Active Chain Control

GEOPAK Element Attributes

GEOPAK 3PC AdHoc Attribute Manager

* v v vBllv v v ¥

User Preferences

Coordinate Geometry

Design & Computation Manager Graphical Coordinate ¢

Quantity Manager Layout Alignments Horizontal

Flans Preparation 3

Skare Graphics
DIl Auto Store Graphics
3
2ol Subdivision wWizard
Cross Sections 3
Litilities y  Layout Profiles (¥PI Based)
Lavout Profiles {Component Based)
Help |
Leqgal Description
About GEOPAK.

Figure 7-4: Accessing Graphical COGO
Or by selecting the icons from the main GEOPAK Road tool dialog

box.
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Road [X]

Graphical COG0

Figure 7-5: Graphical COGO Icons

The Graphical COGO tool frame shown below contains tools for
creating COGO elements such as lines, points, curves, modifying
COGO elements, manipulating elements, and grouping elements.

coGo (X

Figure 7-6: Graphical COGO Tool Frame

From the main Graphical COGO tool frame, shown above, additional
tools may be accessed from each of the four main tool boxes.

Store Elements

= 24

Figure 7-7: Graphical COGO Tools

The Graphical COGO tools shown above, and those
in the Horizontal Alignment Generator, look and act
the same as many MicroStation tools. However,
these tools are not relying on the accuracy of
MicroStation graphics, but rather the much more
accurate GEOPAK coordinate geometry engine.

N,
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Horizontal Alignment Generator (Element Based)

Graphical COGO and the Horizontal Alignment Generator, allow the
user to create coordinate geometry elements, much the same as the
original COGO tools, but with a much more graphic and user-friendly
process.

The Horizontal Alignment Generator can be accessed through the
Project Manager by clicking on the Horizontal Alignment button on the
flow chart and selecting Graphical Element Based geometry.
Horizontal Alignment Generator can also be accessed by selecting:

Applications>GEOPAK ROAD>Geometry>Layout
Alignments Horizontal

Or by selecting third icon in the Horizontal & Vertical Geometry tool
box. Selecting this icon will invoke the Horizontal Alignment Generator
Menu.

|H|:|ri2|:|ntal Alignment Generatu:ur|

Figure 7-8: Horizontal Alignment Generator

& - X
File Design Tables Tools

Figure 7-9: Horizontal Alignment Generator Menu

The File pull-down menu allows the user to set preferences for how
newly created elements will be displayed, how to name elements, and
which geometry tables to use as a default. CFLHD uses the Spiral
Design Tables. To access the Spiral Design Tables, path should be
set to V8_RESOURCE\X_30\Standards\Bin\english or metric.
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& Preferences E|E|E| . q

Cateqaory |
Element Symbology
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Curve Dezign Tables

Spiral Design Table Indexed by Curvature

Spiral Design T ables
Turning Pathz

Fl Aligriment
Geomety Settings
Dyrarmic Increments

Figure 7-10: Horizontal Alignment Generator Preference

The Design Tables menu allows the user to view the settings for the
current default design tables. In the Design Tables pulldown, the user
sets the paths and file names for the tables to be accessed. Currently
CFLHD uses only the Spiral Curve tables (Metric and English). Once
the English or Metric Spiral Curve table is selected, select the design
speed and number of lanes. These tables correspond with the
AASHTO Green Book.

BEE= A=E|

Filz | Design Tables  Tools File:
Symmetrical 3 Centered Curve Selection: [15 mph 2 Lanes ~]
Asymmetrical 3 Centered Curve
Symmetrical Taper Curve Fadiug Spiral = ‘l
Asvrametrical Taper Curve 130 72 4.7
143 i 448
136 7h 45
130 77 50|
123 7a 51
17 20 52 |

Figure 7-11: Design Tables — Spiral Curve

The tools menu activates the COGO tools that will be used to create
geometry elements. Selecting Tools>Main accesses the following
tool frame.
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Figure 7-12: Horizontal Alignment Generator Tool Frame

From the main tool frame, shown above, additional tools may be
accessed from each of the six main toolbox icons.

Lines / Curves

Figure 7-13: Horizontal Alignment Generator Tools

Each of the tool boxes shown above, as well as the tools from
Graphical COGO, may be used together to create any combination of
geometry, from the simplest to the most complex.

Advantages

e Using these tools to set a horizontal alignment, if done
properly, is just as accurate as traditional command line
COGO.

e The user does not have to remember syntax of COGO
commands.
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Disadvantages

7

e The Graphical COGO and Horizontal Alignment Generator
tools can be complicated.

e The process is slower than using store graphics, as detailed
below.

Uses

e When the geometry is known, as the input of As-Built
alignments.

¢ When the user wants to give exact bearings and distances.

Store Graphics

The store Graphics procedure is the simplest and quickest method to
create a horizontal alignment. The user can use standard MicroStation
draw utilities to layout the alignment then use the Store Graphics tool
to store the alignment into COGO. Even though MicroStation
measurements are to single precision, GEOPAK stored elements are
computed to double precision accuracy. Store Graphics will make
slight adjustments to the graphical element locations as required
forcing each element in the chain to be exactly connected to the
immediately preceding element and the immediately following element.
These adjustments are always minor (e.g. the coordinates of a curve’s
PC and/or PT may be adjusted a few millimeters to force the curve to
match the tangents exactly) but they do occur and the user has no
control over them. However, if the graphical elements were drawn
correctly then the chain that gets stored into the gpk file is exactly as
“accurate” as a chain stored using any of the other methods.

TIP: Use the filet tool to construct the final curves in the alignment.
Placing an arc by tangential snap does not always give accurate
results.

This command cannot be accessed using Project Manager, but can be
accessed the following two ways. From the GEOPAK pull down
menus select, Applications>GEOPAK ROAD>Geometry>Store
Graphics
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Figure 7-14: Accessing Store Graphics

Or by selecting the icons from the Geopak Road tool box as shown
below:

Figure 7-15: Store Graphics Icon

Selecting the Store Graphics Icon will invoke the Store Graphics
Dialog box. Points, curves, chains and parcels can be stored with this
dialog box. To store a horizontal alignment, toggle to Chain as shown
below. Set the Mode to Complex Chain. Enter the Job number (use
the magnifying glass to browse to the GPK file), the Operator Code
(users first and last initial), the name of the chain that will be stored
and the Beginning Station of the horizontal alignment.
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& Store Graphics |Z||E|E|
Settings

Jab: | 123 Q
Operator Code: | 5D
TESTCHAIN

Beqginning Station: J 10+00

Madg;  Complex Chain D

ID Elernent I Stare I

Figure 7-16: Store Graphics

The Beginning Point of the chain must be a unique point that has not
been used previously. To check what points have already been used
in the project, go to Coordinate Geometry (COGO) Dialog box as
shown below. Select Element from the top of the COGO Dialog box.
Go to Point and then Utility. This opens the Point Utility Dialog box
which lists all of the points that have been used already. Points can
contain numbers and letters. After determining an unused point, close
the COGO Dialog box (Choose No when the ‘COGO session not
saved’ Alert appears).

File  Edit | Element Misw Tools

Point L3 4 3 de o
MH A e el Oy
R Line » ; 1 ™~ IC-::‘ ;’_} [ - e A Gl ﬁ
o Cel
¥ Bedefin = se|saiza | omanz w| «| < |
i gu.rve M | |
_?2_J $.|m| : Elevation
in ¥ Eguate _:J
b Skation
Profile 3 S;_Ure

Mext Available Settings anaEs s

Compare Points ko TIM
Set Elevation Frarm TIN

X B a

| Point_ =
2

3

4

5

E

7

8 =i

Figure 7-17: Unique Beginning Point
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Enter a unique Beginning Point in the Store Graphics Dialog box. Fit
the entire horizontal alignment in a View (if a portion of the alignment is
not in the view, it will not be stored). Click on the ID Element button.

EE ag3)

|A4=Dadsiand o]

Figure 7-18: ID Element

In the view with the entire alignment, data point the first element in the
horizontal alignment, the element will then appear highlighted. Click
again, and the rest of the elements will be highlighted. Click again to
accept the chain, and the Store button will become un-ghosted. Click
the Store button. Click OK on the Store Graphics Notification.

= =5
| Settings
Jobe [123 Q

Operator Code: ISD—

Chain | [TESTCHAIN

Beginning Point: IALI'Ii
Eeginhing Station: W

Mode: Complex Chain = ™

1D Element | Stare %J

Store Graphics Mokification
0 Chain TESTCHAIM will be stored in job 123,

Store chain command will be added toinput: file j123050.inp

Cancel

Figure 7-19: Store Chain
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Advantages

o Use simple MicroStation commands to layout alignment,
adjustments to alignment are quick, and the only point numbers
used are on the alignment (usually just the first and last).

Disadvantages
e Not as accurate as COGO. Store Graphics makes minor
adjustments to the as-drawn elements in order to get them to
tie together mathematically.
¢ Cannot draw spirals using MicroStation commands. If spirals
are needed, you must use Horizontal Alignment Generator to
create that element, and then you may continue using
MicroStation commands.
Uses

e For general and normal chain creations.

e For long alignments with many elements.
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Coordinate Geometry (COGO) Tools — Geopak 2004

In GEOPAK 2004 there have been few enhancements to the workings
of the existing coordinate geometry tools. The main COGO dialog box
has been enhanced to include utilities for each type of COGO element
such as points, lines, curves, chains, etc. The utility dialog box will
allow the user to functions such as visualize, print, transpose, etc., for
each element type. This allows the user to more efficiently work with
each type of element independently. The new COGO dialog box,
along with some of the utility dialog boxes is shown below.

& Coordinate Geometry Job: 100 Operator: jb |Z||E|[g|
File Edit Element View Tools User
- 1 e e 4 4 g 57 B = X
<= H () @ @ Qe B@) * i v
Dizable Visualization * |[OFFFeatus] | Browse | 9912 | 949912 v| Z j j B
£0G0 keyn; [ Rd!

Poaint | |} [Ltine | 1| [Curve [Chain

Figure 7-20: New COGO Tools
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Vertical Design /|

There are two methods available for creating and storing an Existing
Ground profile; Traditional method and the new Draw Profile Tool
method.

Traditional Existing Ground Profile Tool

Once a run is created for the working alignment, the existing ground
profile should be created and then drawn using the D & C Manager.
CFLHD’s traditional method for cutting existing ground profile is shown
below. Existing Ground Profile can be accessed through the Project
Manager by selecting the Existing Ground Profile button.

& Road Project: FHWA. prj

File Remember Options
“Working Directory:  o:%our_ProjecttFoadwaptDesign

SEIES

User: John Job i 101 |
¥ Working Alighment Influgnce Runs

Working alignment  MAIN

{Celent Defing | Part Viewer |

E sizting
Giraund Draw Pattemn Exizting Ground E wizting Ground ertical
Croszs Sechions Profile Alignment
. ™
Coordinate
Geometry
Calculate Supereleyation Proposed a0
Superelevation Shapes Cross Sections Models
Harizontal
Alignment
Flan e E i Emgshs etctlon
Design 1558
Flan Wigw Tabular
Quantities Summaries
Flan & Frofile Limits of Reports & =5
Sheets Construchion Quantities

Figure 7-21: Accessing Existing Ground Profile through Project
Manager

The Existing Ground Profile dialog can also be accessed by typing in
mdl load ex_prof command in the MicroStation Key-in box.

mdl load ex_prof

- B % -

Figure 7-22: MicroStation Key-in

The following Existing Ground Profile dialog box will appear.
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& Ground Profile E]|E|@ ““

Profile Name: [EXMAIN Select.. |
Job Number: [101 Q]
Operator: [JD

Chaire [MAIN Select...|
Offzet: [0.000

Eeg Statior: | 10+00.00
End Statior: | 41+60.65

Increment ™ | | 5.000 TIN b

Commitmant fo Excellance

TIM File? [l our_Project\Surveyhdl  Files. .

Apply

Figure 7-23: Traditional Existing Ground Profile

Enter in the required information and select Apply. Apply will cut your
existing ground profile for the chain and store it into the GPK file.
Existing ground profile can be accessed and drawn into MicroStation
using the Geopak D & C Manager, with the CFLHD .ddb file. This will
assure that the existing ground profile is placed with the correct
symbology.

Draw Profile Tool - GEOPAK 2004

New to GEOPAK 2004 is a streamlined way to create existing ground
profiles, and plot both existing and proposed profiles. The Draw
Profiles tool is not available through project manager workflow dialog
box, but can be accessed by selecting Applications>GEOPAK
ROAD>Plans Preparation>Draw Profiles
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GEOPAK ROAD Tools
Project Manager

Site Modeling

active Chain Contral

GEOPAK Element Attributes

GEOPAK 3PC AdHoc Attribute Manager

User Preferences
Geometry 3
Design & Computation Manager

Quantity Manager

Plans Preparation

Plan Yiew Labeling

DT Tools DP Station/Offset

3D Tools ¥ Draw Transition

Eresssections k Draw Cell by Feature

Heikies g Draw Cell Group by Feature

Help Draw Cell Area by Feature
Pavement Markings

About GECPAK

Draw Signs

Profile Labeling

Draw Profile Tabular Data

Plan/Profile Sheet Composition
Tables

Figure 7-24: Select Draw Profiles

The Draw Profiles tool may also be accessed from the Plans
Preparation tool palette as shown below.

2 A @ 24
d | L[tn (Ttrerry Mo

A orrr
rrr

Figure 7-25: Draw Profile Icon

All that is needed for this tool is a horizontal alignment and a .tin file.
This tool allows for the creation of an existing ground profile in much
the same way as the Traditional method, but does so behind the
scenes, with increased efficiency and a much cleaner workflow. This
tool also allows the user to draw profiles into MicroStation using the
D&C Manager .ddb settings ensuring adherence to the CADD
standards. Also, with the Draw Profiles tool, there is no need to delete
before re-drawing updated profiles.
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Workflow 1: Creating an existing ground profile using 4
Draw Profiles Tool |
To access this workflow, follow this link:

http://www.cflhd.gov/cadd/ documents/Creating existing ground
profiles with Draw Profiles Tool - (Workflow 7.1).pdf

One advantage of using the draw profile tool is the
® Update application. With this, it is possible to
l update all profiles and the Label Scale with one
click. The user does not need to delete and redraw
elements.

& Draw Profile
File Edit Update Options

er; NIEEN ~ |
Chain: [SOUTHZ =]

& Wahel Seale: [0O0OOON0

Surfaces | COGO | Projection |

Z Draw Profile E“El@

File Edit Update Options

Job Mumber: [101 _= '@ ﬁ Label Scale: | 100.0000
Chain: |MAIN hd

Surfaces | COGO | Prajection |

Mame Dizplay Settings Diraw

EXPROF

gndd Caogo Profile Settings

Details

Profile Mame: [ExMAIN =] [ Station Limks
. ir; , e
Vertical Offset | 0.00 [ Begin: | 10+00.00 J

T End 1155248
Display Settings

M _______ Custom Line Style
Feature: [EXPROF = ﬁ ™ Scale factor: [0.0000

Options
Stip Grade Increment: | 50.00
WP ¥ Horizontal Axis Labels
VL ¥ Wertical Axis Labels
[T Station Equation

Figure 7-39: Profile Drawn into MicroStation

The projection tab can be used when the chain and profile that needs
to be drawn is different than the chain and profile used to create the
profile cell.
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8 Draw Profile g@|@

File Edit Update Options

Job Mumber: 101 _= d;ﬁ E Label Scale: | 0.000000

Chair: |MalM
Surfaces | EDG@
Type Chai ——Frfe /S urf Dizplay Settings Ciraw |
]
Detailz™

. Stationi
Type: Survey Chain ™ EHEAIAE

Yertical Offzet: | 0.00 = g
[~ POT
¥ Extraction from Surface Filter Tolerances
TIM File: | e:Mour_Proje: ﬂ Harizontal: |0.10
Method: Triangles Yariahce: | 0.03

Dizplay Settings

By Lewvel Symbology ™ _
=T [T

Figure 7-40: Profile Projection Tab

Proposed Vertical Alignment

There are two tools used to set proposed vertical alignments, and both
are acceptable to CFLHD. Engineers and designers have used the
VPI based Vertical Alignment Generator since the early days of
GEOPAK. This tool, although having been around for years is still a
user-friendly, accurate method for creating and storing vertical
alignments. The second method is the Component Based Vertical
Alignment Generator. This tool has been updated and improved over
the VPI based tool, and has yet to be fully utilized by most GEOPAK
users. Both these methods are just as accurate and depending on
your preference, as easy to use.

VPI based Vertical Alignment Generator

The VPI based Vertical Alignment Generator is the traditional method
used by CFL designers in creating vertical alignments. Vertical
alignment generator can be accessed through Project Manager by
selecting the Vertical Alignment button.
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& Road Project: FHWA. prj E|E|®
File Remember Options
Wwharking Directory: o %'our_Project'R oadwaptD ezign User John Job#: 101 ]
W Working Aligrment Influsnce Funs
Defi Pt Wi

Working Aligrment MAIN Defne | _PartViewer |
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Giround Draw Pattam Existing Ground E xizting Ground Wertical

Cross Sections Profile Alignment

Coordinate

Geometry

Calculate Superelevation Fropozed 30
Superelevation Shapes Crozs Sechons Models

Harizantal
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Design eels
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Quantities Summaries
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Figure 7-41: Accessing Vertical Alignment through Project Manager

The VPI Based Vertical Alignment Design Tool may also be accessed
from the Horizontal & Vertical Geometry tool palette as shown below.

x|

= —— ,
= I]]III?' |'u'F‘I Based Yertical alignment Design Tools

Hort

Figure 7-42: VPI Based Vertical Alignment Icon

Selecting the VPI Based Vertical Alignment Design Tool will invoke the
dialog box below:
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& Settings [ ‘
ilob Number! [T ey '
Operator Code: | JD
FGL Chain: (&M hd

Location and Scales

Harizontal Scale: IW
Wertical Scale: IW
Reference Station: IW
Reference Elevation: lm
w: [B33709.39072

v [T o

Profile Cell
Draw Cell at Y| Idertiy Cel |

ok | Cancel |

Figure 7-43: VPI Based Vertical Alignment Settings

Once the settings are defined, selecting OK will invoke the GEOPAK
Profile Generator.

& Profile Generator (K Value Table: KValues_2004english. kvl)

| File  Tools

Profile Cell Settings. ..

r—  of >
S0t bk Elevatior: | 0Of *
Load Profile...
Save Profile ] Dgnamic] I I

Save Profile as...

Clear Profile
Draw Profile

Exit

Figure 7-44: Profile Generator

For US Customary projects, the User Preferences are as shown
below:

& Preferences [%|

Elewation Increment; | .01

Length Increment; | .01

Grade Increment: | 00071
 Maintain Curve K Value e E
[+ HoldYertical Curve

W window Center Cument P

1] Cancel |

Figure 7-45: User Preferences
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Commitmant fo Excellance

If the project requires the use of Maintaining K value instead of
Maintain VC Length, commonly used, attach the correct K-Value table.
K Value Table can be accessed by selecting User>K-Values. The
following dialog will appear:

& K Yalues (K Value: KValues_2004english.kvl) =]0X]
File
% Sag Min Sag kax Crest Min Crest Max -
Sa 10.0 10.0 20 30
Save as 17.0 17.0 7.0 7.0
Eit 26.0 26.0 120 120
70 370 19.0 19.0
430 430 230 290
B4.0 B4.0 440 440
730 79.0 £1.0 £1.0 =]
[20 [Z31.0 [Z31.0 [Z84.0 [Z84.0
ok | Cancel | add | Delete |

Figure 7-46: K-Value Table

Use File>Open to attach the correct unit K-Value table (.kvl). K-Value
table can be attached from V8_RESOURCE\X_30\Standards\Bin\
english or metric.

After the proposed vertical alignment is created and saved, use the
Draw Profile Tool or the D&C Manager to drawn profile in MicroStation,
ensuring adherence to the CADD standards. For CFLHD projects, the
toggles shown below must be selected prior to drawing the profile.

& Draw Plan & Profile B0 E

ltern: [DPROF Design profile
Element Type:  Profiles ¥ | LabelScale: [ 100
i |

Select Profile to Draw *]

ExMAIN ¥ WPl Labels From WPl ¥
FRMAIN B v

¥ Horizontal Awiz Labels

W Vertical Aviz Labels

[ WL Incremental Elevations

WV W.C. Parameters

Iv Grade Labels +and- W
M K¥alues

[ Esternal Lengths

~

r

v

Station Equations Mo Gaps ™

YPCAFT Labels

‘Stopping Sight Distances:

Figure 7-47: D & C Manager to Draw Profile Draw
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Component Based Vertical Alignment Design Tool “E“
The new method to create vertical alignment introduced with :
Geopak 2000 is the Component Based Vertical Alignment Design

Tool. This method allows for vertical alignment to be created

graphically and stored using Store Graphics command, similar to the

horizontal alignment Store Graphics command. The Component

Based Vertical Alignment Design Tool requires COGO to be active as

well as an Active Chain and Active Profile Cell. Component Based

Vertical Alignment Design Tool requires the use of Active Chain

Control, a method introduced with Geopak 2000. Active Chain Control

can be used in place of the 3 port viewer.

Workflow 2: Creating Proposed Vertical alignment
using Component Based Vertical Alignment Design
Tool

To access this workflow, follow this link:

http://www.cflhd.gov/cadd/ documents/Creating Proposed Profiles
using Component Based Vertical Alignment Design Tool -
(Workflow 7.2).pdf

The various methods for creating horizontal and vertical geometry
using GEOPAK are describe in this chapter. Regardless of the
method used, the final alignment and profile must be drawn into
MicroStation using the GEOPAK D&C Manager, with the CFLHD .ddb
file. Workflow 3 outlines a macro used at CFLHD to check the
horizontal alignment design for kinks.

Workflow 3: Macro - Checking for Kinks in Horizontal
Alignment
To access this workflow, follow this link:

http://www.cflhd.gov/cadd/ documents/Macro for Checking for Kinks in
Chains - (Workflow 7.3).pdf
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http://www.cflhd.gov/cadd/_documents/Workflow_7.2_HVDesignCreatingProposedProfilesusingComponentBasedVerticalAlignmentDesignTool_x30.pdf
http://www.cflhd.gov/cadd/_documents/Workflow_7.2_HVDesignCreatingProposedProfilesusingComponentBasedVerticalAlignmentDesignTool_x30.pdf
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